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Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital
apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus”,
ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur la matériel brouilleur: “Appareils Numériques”,
NMB-003 édicatée par l’Industrie Canada.

International ENERGY STAR® Program
As an ENERGY STAR® Partner, Canon Inc. has determined that this product meets the ENERGY STAR

guidelines for efficiency.

The International ENERGY STAR® Office Equipment Program is a global program
that  promotes energy saving through the use of computer and other office equip-
ment. The program backs the development and dissemination of products with
functions that effectively reduce energy consumption. It is an open system in
which business can participate voluntarily. The targeted products are office equip-
ment such as computers, monitors, printers, faxes and copiers.
Their standards and logos are uniform among participating nations.

Power Requirements
Never use a power supply voltage other than that supplied in the country of purchase. Using the
incorrect voltage could cause a fire or electric shock. The correct power supply voltages and frequen-
cies are as follows:

Europe AC 230V±10%, 50Hz
USA/Canada AC 120-127V, 60Hz 
Australia AC 240V, 50Hz 
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Preface
�� Shipping Materials  �����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact
your Canon Authorised Dealer or Sales Representative.

❏ Printer
❏ Setup Software & User’s Guide CD-ROM
❏ Quick Start Guide
❏ BJ Cartridge (print head plus two ink tanks)

* A USB cable should be purchased separately according to your computer. For details on
cable specifications, refer to page 3.

�� Introduction  ���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
This Quick Start Guide uses the following symbols to indicate important information.  Always
observe the instructions indicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by
incorrect operation of the equipment.  These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by
incorrect operation of the equipment.  These must be observed for safe operation.

Also read the Safety Precautions in the User’s Guide. Observe the warnings and cautions to
avoid personal injury or damage to the printer.

Trademark Notices
• Canon® is a registered trademark of Canon Inc.
• BJ™ is a trademark of Canon Inc.
• Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the U.S.

and other countries.
• Apple, Mac, Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and

other countries.
• All other trademarks and registered trademarks appearing in this Quick Start Guide are

the property of their respective owners.

Copyright ©2001 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form
whatsoever without the express written permission.
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1 Place the printer on a flat surface.

2 Remove the tape from the printer as
shown.
Ensure to remove the tape inside the printer.

3 Attach the paper rest to the sheet
feeder.

4 Attach the output tray as shown.
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Setting Up
�� 1 � Preparing the Printer  ������������������������������������������������������������������������������������������������������������������������������������������������������������������������

paper rest

output tray
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Follow the steps below to install the printer
driver correctly.

1 Unplug the printer and ensure the
computer is switched off.

2 Connect the cable.

3

➥Note
If the Add New Hardware Wizard or Found New Hardware
Wizard screen appears when carrying out the following
operations, click Cancel and turn off the computer.

�� 2 � Connecting the Printer to the Computer  ��������������

Use a USB cable.

USB cable

Recommended: Canon or other computer manufacturer cable, up to 5 meters in length.

➥Notes
• If your computer has an earth connection, make sure that this is attached.
• If you do not intend to use the printer for a long period of time, unplug the power cord

from the power outlet.
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1 Plug the printer in. Do NOT turn on the
computer yet.
The printer is turned on and enters Standby
mode.

2 Open the front cover.
The cartridge holder moves to the centre.

4

�� 3 � Installing the BJ Cartridge  ������������������������������������������������������������������������������������������������������������������������������������������

• Never attempt to plug the power cord into the power outlet or unplug the power cord
when your hands are wet.

• Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place
heavy objects on the power cord.

• Never use any power supply other than the standard power supply available in the
country of purchase. Using the incorrect voltage and frequency could cause a fire or
electric shock.

• Always push the plug all the way into the power outlet.
• Install only the print head packed in the printer package. Do not install any other print

head in any case. It will never work.

� Installing the BJ Cartridge

3 Unpack the BJ Cartridge.

cartridge holder
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4 Remove the protective cap and tape
from the BJ Cartridge.

➥Notes
• Do not touch the

print head nozzles or
electrical contacts.

• Do not attempt to
reattach the
protective cap once it
has been removed.

5 Place the BJ Cartridge in the holder.

5

6 Lock the BJ Cartridge into place by
lowering the lever.
Do not touch the lock lever once the print head
has been installed.

electrical 
contacts

print head
nozzles

print head

7 Close the front cover.
Wait until the printer stops operation.

protective cap

tape
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1 Open the front cover.

2 Move the paper thickness lever at the
top of the cartridge holder to the left
position. Close the front cover.

➥Note
Set the paper thickness lever to the left when
using plain paper, to the right when using thick
paper. Refer to the User’s Guide for
information on loading envelopes and other
media.

3 To avoid paper jams, fan the stack to
remove static cling, then align the edges
of the stack by tapping it on a flat
surface.

4 Load the paper, aligning it with the right
side of the sheet feeder.
You can load up to 50 sheets of plain paper. Do not
exceed this limit.

5 Press the paper guide and slide it
against the left side of the stack of
paper.

You now need to install the printer driver:
Windows: Go to page 7
Macintosh: Go to page 9

�� 4 � Loading Paper  ����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
� Loading A4 (Letter) Size Plain Paper

print side

paper thickness lever

limit mark
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1 Unplug the printer and ensure the
computer is switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.
Disable any virus detection programs.
Do NOT turn the printer on at this stage.

3 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

➥Notes
• If the CD-ROM does not run automatically,

double-click My Computer in the Windows
screen, then double-click the CD-ROM icon.

• If the language selection screen appears,
select a language, then click the Next button.

�� 5 � Installing the Printer Driver  ������������������������������������������������������������������������������������������������������������������������������������
� Installing the Printer Driver - Windows

➥Notes
• Do not disconnect the cable or remove the CD-ROM during the installation. The driver

cannot be correctly installed.
• The screens below refer to Windows Me installation. Screen may differ depending on

the environment you are using.
• When installing the printer driver in Windows XP/Windows 2000, log on to the system

as a member of the Administrators group.

If the following screen appears automatically, click Cancel and carry out the installation
following steps 1 to 7.

Special Notes for Windows 98 USB Users

Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB
cable connected to your computer.
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4 Read the displayed license agreement,
then click Yes.

5 Ensure the Printer Driver is reversed,
then click Install.

6 When the screen shown on the left
appears, plug the printer in.
If the printer is recognised,  the printer driver will
be automatically installed.

➥Note
If the connection is not recognised, refer to the
section “Notes on Handling the USB Interface
(for Windows Users)” on page 19.

7 Click OK.
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8 When the screen shown on the left
appears, click Exit.

➥Note
If a message prompting you to restart the
computer appears, click Yes to restart your
computer.

� Installing the Printer Driver - Macintosh

➥Notes
• Do not remove or insert the USB cable during installation, as this may result in the

computer or printer not operating normally.
• Before installing the driver, disable all virus detection programs and automatically

loading programs or remove them from your system folder.

1 Turn on the Mac.

2 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

3 Double-click the printer driver folder,
then select a language.

4 Double-click Installer.

5 Read the Licence Agreement and click
Accept to continue.
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6 Click Install.
Wait for the installation to finish.

➥Note

If the above message appears, check that there
are no unsaved documents, then click the
Continue button. If a document needs to be
saved, click Cancel then save the document.
After saving the document, begin again from
Step 4.

7 Click Restart.
The computer restarts.

8 Select Chooser in the Apple Menu.

9 Click the icon for the printer you are
using and close Chooser.
Before you use the printer, you must carry out
print head alignment.

➥Note
Refer to the User’s Guide when using this
printer as a network printer.
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1 With the printer on, load a sheet of A4
or Letter paper in the printer.

2 Click Start and select:
• Windows Me/Windows 2000/Windows 98 �

[Printers] in Settings
• Windows XP � [Control Panel]-[Printer and

Other Hardware]-[Printers and Faxes]

3 Click the icon for your printer.

4 Open the File menu and select:
• Windows Me/Windows 98 � [Properties]
• Windows XP/Windows 2000 �

[Printing Preferences...]

to open the Printer Properties dialog
box.

5 Click the Maintenance tab, and then
click the Nozzle Check icon.

6 When the confirmation message is
displayed, click OK.
The printer starts printing a nozzle check pattern.

�� 6 � Printing the Nozzle Check Pattern  �����������������������������������������������������������������������������������������������
You have made all preparations necessary for printing. The printer is now ready to use. Next,
print a trial pattern, or nozzle check pattern.

� Printing the Nozzle Check Pattern - Windows
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� Print the Nozzle Check Pattern - Macintosh

7 Examine the printed nozzle check
pattern to check if all colours (yellow,
magenta, cyan, and black) are printed
and all lines are drawn completely.
If this pattern is not printed completely, clean the
print head. Refer to Section “Examining the
Nozzle Check Pattern” of the User’s Guide on
page 80 for how to check the printed nozzle check
pattern.

If ruled lines are horizontally misaligned, you
have to adjust the print head position. Refer to
Section “Aligning the Print Head” of User’s
Guide on page 85.

➥Note
If ruled lines are printed irregularly, adjust the
print head position. They will be printed
correctly.

1 With the printer on, load a sheet of A4
or Letter paper in the printer.

2 Select Page Setup in the File Menu.

3 Click Utilities.

4 Select Test Print from the menu, and
click the Nozzle Check icon.

5 When the confirmation message is
displayed, click OK.
The printer starts printing a nozzle check pattern.
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6 Examine the printed nozzle check
pattern to check if all colours (yellow,
magenta, cyan, and black) are printed
and all lines are drawn completely.
If this pattern is not printed completely, clean the
print head. Refer to Section “Examining the
Nozzle Check Pattern” of the User’s Guide on
page 80 for how to check the printed nozzle check
pattern.

If ruled lines are horizontally misaligned, you
have to adjust the print head position. Refer to
Section “Aligning the Print Head” of User’s
Guide on page 86.

➥Note
If ruled lines are printed irregularly, adjust the
print head position. They will be printed
correctly.
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1 Print the document from the
application.
On the File menu, click Print.
Check the application’s users manual for the
actual procedures.

2 Ensure your printer is selected, then
click:
• Windows Me/Windows 98 � [Properties]
• Windows XP � [Preferences]
• Windows 2000 � Main tab

3 Specify the required settings and click
OK.

➥Note
If you use anything other than plain paper,
please refer to “Basic Print Settings” on
page 15.

4 To start printing, click:
• Windows Me/Windows 98 � [OK]
• Windows XP/Windows 2000 � [Print]

Printing will start in a few moments.

Basic Operations

• If you detect smoke, unusual smells or strange noises around the printer, immediately
unplug the printer.

• To avoid injury, never put your hand or fingers inside the printer while it is printing.

�� Printing with Windows  ������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use WordPad for the purpose of explanation. The procedures you use
and the screens that appear on your computer may differ according to the application that you
use.

� Printing
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� Basic Print Settings
For the best print quality, specify the minimum requirement settings in the Main tab. To get
the best results, ensure you select the type of media loaded in the printer when printing on
paper other than plain paper.

(1) [Media Type] Select the type of media loaded in the printer.

(2) [Print Quality] Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) [Colour Adjustment]/ If you wish to control the colour adjustment settings in more detail, 
[Color Adjustment] select Manual.

(4) [Help] button Click this for a more detailed explanation of the functions in this
settings tab. (This may not appear when using Windows 2000. If this
happens, click Start then select Programs - Canon S200 - Guide).

(5) [?] button Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

➥Notes
• Clicking the Print Advisor allows you to change to the most appropriate print settings

simply by answering questions when prompted.
• Use the application to set the paper size and paper orientation. Before printing, open

the settings screen and check that the Page Size in the Page Setup tab is the same as
that specified within application.

• Refer to the User’s Guide for more information about printer driver functionality.
• To print with good quality, we recommend that you use the printer at temperatures

from 15°C to 30°C.

(5)

(1)

(2)

(3)

(4)
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1 Open the Page Setup dialog box in
your application.
On the File menu, click Page Setup. Check the
application’s users manual for the actual
procedures.

2 Specify the page setup.
For details, refer to “Page Setup” on page 17.

3 Open the Print dialog box in your
application to print the document.
On the File menu, click Print. Check the
application’s users manual for the actual
procedures.

4 Specify the print settings according to
your requirements.
For details, refer to “Basic Print Settings” on
page 17.

5 Click the Print button.
Printing will start in a few moments. 

�� Printing with Macintosh  ��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
Adjusting the print settings according to your needs allows you to produce better quality prints.

� Printing
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� Page Setup
Use the Page Setup dialog box to specify the paper size settings.

� Basic Print Settings
For the best print quality, specify the minimum requirement settings in the Print dialog box.
To get the best results, ensure you select the type of media loaded in the printer when
printing on paper other than plain paper.

(1) [Media Type] Select the type of media loaded in the printer.

(2) [Print Mode] Select the icon closest to the type of document you want to print.
To specify more detailed settings for the print quality or colour, select
Manual and click Details.

(3) [Print] button Click this to start printing.

➥Notes
• See Balloon Help for more information about other printer driver functions.

Select Show Balloons in the Help menu for an explanation of each of the items in the
setting screen. To see the explanation, point to the item with the mouse.

• Refer to the User’s Guide for more information about printer driver functionality.
• To print with good quality, we recommend that you use the printer at temperatures

from 15°C to 30°C.

17

Select paper
size you wish
to use.

(1)

(2)

(3)
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1 Open the front cover.
The cartridge holder moves to the centre.

2 Remove the empty ink tank.
Do not touch the lock lever. You do not need to
remove the print head.

3 Install the new ink tank.
Close the front cover when finished.

➥Note
When you enable the low ink warning, reset
the ink counter of the ink tank installed.
Refer to the User’s Guide for more detailed
procedures and information about
maintenance.

Print Head Maintenance

� If Blurring Occurs or If a Specific Colour Does Not Print
Perform print head cleaning to improve the print quality. Ensure that the printer is pluged
in and follow the instructions below.

• Windows
Open the printer driver settings screen and click the Maintenance tab. Click the Cleaning icon.
See page 11 for details on how to open the setting screen.

• Macintosh
Open the Page Setup dialog box and click the Utilities button. Click the Cleaning icon.

� When the Printer Runs out of Ink
Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Ink Tank BCI-24 Color
Ink Tank BCI-24 Black

colour black lock lever
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If you cannot proceed beyond the connection
destination screen:

1 Click Cancel.

2 When the Abort Installation screen is
displayed, click Abort.

3 When the Terminate Installation screen
is displayed, click OK.

4 Unplug the printer.

5 Reinstall the printer driver (see page 7).

Notes on Handling the USB Interface (for Windows Users)
If installation of the printer driver does not proceed as instructed in this Quick Start Guide,
there may be a problem with the USB driver installation.
Try reinstalling the printer driver.

� Reinstalling

If the installation still does not proceed as instructed, check the status of the USB driver
following the procedures described below.

� Checking the USB Driver Status

1 Ensure the computer and printer are
connected using the USB cable and that
the printer is turned on.

2 Select Start, Settings and Control Panel.
In Windows XP, after clicking the Start button,
select Control Panel. Select Printers and Other
Hardware.

3 Double-click System.
If the System icon is not displayed for
Windows Me users, click on view all Control
Panel options on the left-hand side of the screen.

4 Click the Device Manager tab.
For Windows XP, click the Hardware tab then
click Device Manager.

5 Double-click Universal Serial Bus
controllers.

6 Check that Canon S200 is displayed.
• If displayed, installation is complete.
• If displayed with an exclamation mark (!),

installation was not successful. Delete and
reinstall.

• If nothing is displayed or Other Devices is
displayed instead, installation was not
successful. Delete and reinstall.

Refer to the User’s Guide for details on how to
delete unknown devices.

If displayed with an exclamation
mark ( ! )

If Other Devices is displayed
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For Windows
(1) Load the CD-ROM in your computer.
(2) Click View Documentation.

If Acrobat Reader is not installed or
Acrobat Reader 4.0 is installed, a
message appears. Click Yes.  Follow
the instructions on screen to install
the program. The User’s Guide will
appear once installation is complete.

For Macintosh
(1) Load the CD-ROM in your computer.

If Acrobat Reader 3.0 or later is not
already installed, double-click the
Acrobat Reader 4.0 folder in the CD-
ROM folder, then double-click
Reader Installer. Follow the
instructions on the screen to install
Acrobat Reader.

(2) Double-click the Manual folder.
(3) Select a language folder.
(4) Double-click the icon for the

S200_UG_UK.pdf file.
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� BJ Printer Driver Systems Requirements
For Windows
• Windows XP, Windows Me, Windows 2000, Windows 98
• USB interface

* Use a computer on which Windows XP, Windows 2000, Windows Me, or Windows 98
has been preinstalled (including computers preinstalled with Windows 98, Windows Me
upgraded to Windows 2000).

• 15MB of available hard-disk space for Windows 98/Windows Me
• 25MB of available hard-disk space for Windows 2000 
• 16MB of available RAM for Windows 98
• 32MB of available RAM for Windows Me/Windows 2000

For Macintosh
• Macintosh series computer equipped with USB interface
• Preinstalled Mac OS 8.6 - Mac OS 9.X
• 30MB of available hard-disk space (including temporary storage space)
• 12MB of available RAM (unused block)

Additional Systems Requirements for User's Guide
To install Adobe Acrobat Reader and view the User's Guide:
• 8MB of available hard-disk space for Windows
• 13MB of available hard-disk space for Mac OS
• 640 x 480 pixels or greater, minimum 256 colours video display

For Further Details...
For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM
drive.

� User’s Guide Contents
The “User’s Guide” is in PDF format and can be found on the same CD-ROM as the printer
driver. You can view this Guide on screen and print out any sections you require.

Contents
• Printer parts and their functions • Printing media
• Printer driver functions • Troubleshooting
• Routine maintenance • Specifications

� How to View the User’s Guide
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